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1 Introduction
RAIDmap (for Research Activity Information Development Mapping) is a prototype application to help researchers organize their research data records. It provides a file metadata
harvester and a means of visualizing the associations between both digital and physical
records which constitute research data sets.

2 Setting up a development environment for RAIDmap
2.1 Java
1. Make sure that Java is installed. You will need the Standard Edition of the Java
Development Kit version 5 or later. The latest version may be downloaded from
the Oracle Web site here: http://www.oracle.com/technetwork/java/javase/
downloads/

2. Set the Environment Variable JAVA_HOME to the directory in which the Java JDK
has been installed, e.g. C:\Program Files\Java\jdk1.5.0_12. You can do this in
Windows by
• holding down the Windows key and pressing Pause, or
• running start sysdm.cpl from the Command Prompt, or
• opening the Start menu, right-clicking on Computer and selecting Properties
then selecting the Advanced tab (via Advanced System Settings in some versions of
Windows) and clicking the Environment Variables button. Note that you do not need
to wrap the pathname in quote marks even if it contains spaces (see Figure 1).
3. You should also ensure that %JAVA_HOME%\bin (Windows) or $JAVA_HOME/bin (otherwise) appears in your Path Environment Variable.

Figure 1: Editing an Environment Variable in Windows.

2.2 Maven
1. Make sure that Maven is installed. You will need version 2.2 or later. The latest version of Maven is available for download from http://maven.apache.org/download
.html

2. Set the Environment Variable M2_HOME to the directory in which Maven has been installed, e.g. C:\Program Files\Apache Software Foundation\apache-maven-3.0
.4. For how to set Environment Variables, see Section 2.1, Item 2
3. Similarly, set the Environment Variable M2 to %M2_HOME%\bin (Windows) or $M2
_HOME/bin (otherwise).
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4. Ensure that your Path Environment Variable contains %M2% (Windows) or $M2 (otherwise).
5. Verify that your installation is working by running mvn -version from the Command Prompt. You should get a message similar to that shown in Figure 2.

Figure 2: Testing to ensure Maven is correctly installed.

2.3 Eclipse
Eclipse is an integrated development environment written in and primarily used for
coding Java, though support for other languages is available. Some support is given later
in this guide for working with the RAIDmap code in Eclipse. If you do not have a working
installation of Eclipse but would like to, several different configurations of the software
may be obtained from http://www.eclipse.org/downloads/; the ‘Eclipse IDE for Java
Developers’ is recommended as a suitable initial configuration.
Please ensure the Maven Integration for Eclipse (m2e) plugin has been installed. This can
be done within Eclipse either through the Eclipse Marketplace (Help > Eclipse Marketplace)
or by selecting Help then Install New Software, and searching the main software repository
(http://download.eclipse.org/releases/〈release name〉) for ‘Maven’. Once you have
this installed, it may take Eclipse several hours to download and install the index for the
official central Maven repository. It is recommended, therefore, that once this is done
you open Window > Preferences, navigate to Maven and untick the option to Download
repository index updates on startup. Within the same preferences section, under Installations you should also add and select your regular Maven install instead of the embedded
version, and either there or under User Settings ensure that Eclipse has found your local
Maven repository: by default, this is in a (possibly hidden) directory .m2 in your home or
user directory.

3 Working with the source code snapshot
There are two ways of obtaining the RAIDmap source code. The first, described in this
section, involves the source code snapshot, which is the code underlying the installer
files. The second, described in Section 4, involves working directly with the very latest
version of the code.

redm5rep120510ab10.pdf
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3.1 Obtaining the RAIDmap source code
The source code snapshot may be downloaded from SourceForge: https://sourceforge
.net/projects/raidmap/files/. Once you have obtained your copy of RAIDMap Project
Workspace.zip extract it somewhere on your local system.
The RAIDmap application uses some libraries that Maven does not know about by default.
Some DOS batch scripts are provided for installing these libraries to your local Maven
repository. These scripts may be found within the RAIDMap Project Workspace directory
in the following locations:
• compendium\MavenExtraLib\ExtraLibInstallCommand.bat
• metadata-extractor\MavenExtraLib\ExtraLibInstallCommand.bat
Similar Bash scripts are also provided for other platforms. If running these from the
Command Prompt, be sure to navigate to the respective MavenExtraLib directories first
so the relative pathnames in the scripts point to the correct locations.

3.2 Building the RAIDmap application
1. Open a Command Prompt and navigate to the RAIDMap Project Workspace directory.
2. Run the following command and wait for it to finish:
mvn clean install -Dmaven.test.skip=true -Dmaven.compiler.source=1.5
-Dmaven.compiler.target=1.5

This will install a jar files for the various components of the application to the local
Maven repository.
3. At the Command Prompt, navigate to the compendium directory within the RAIDMap
Project Workspace directory.
4. To compile the executable jar file, run the following command:
mvn assembly:single -Dmaven.test.skip=true

It will be saved in the target subdirectory with the name compendium-1.0-SNAPSHOT
-jar-with-dependencies.jar. Rename it raidmap.jar.

5. Finally run and test the application by navigating to the target directory and
running the following from the Command Prompt:
java -jar raidmap.jar

It is also possible to build the application from within an integrated development environment such as Eclipse (see Section 3.3), though it is best to check the process works at the
Command Prompt using the above instructions before attempting this. The instructions
for building RAIDmap within Eclipse are as follows.
1. In the Package Explorer, navigate to the compendium project and select pom.xml.
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Figure 3: Configuring the Maven build process in Eclipse.

2. Either right-click to get the context menu, or open the Run menu from the menu
bar, and then select Run As > Maven build. The second time you do this and
subsequently, Eclipse will build the application using Maven. The first time you
do this, however, you will be presented with a dialogue box to configure the build
process (see Figure 3).
3. Under Goal, enter assembly:single and tick the box marked Skip tests. Then select
Run.
4. The executable jar file will be saved in the target subdirectory with the name
compendium-1.0-SNAPSHOT-jar-with-dependencies.jar. Refresh the compendium
project within Eclipse, then locate the file and rename it raidmap.jar.

3.3 Importing the RAIDmap application into Eclipse
1. Locate the RAIDmap Project Workspace directory and inspect the compendium
and metadata-extractor subdirectories. In each case, ensure that the directory
does NOT contain a file named .classpath or a subdirectory named target or
.settings. These will be generated by Eclipse on import, and should not exist
beforehand.

redm5rep120510ab10.pdf
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Figure 4: Importing a Maven project into Eclipse.

2. Open a Command Prompt, navigate to the RAIDmap Project Workspace directory
and run the following four commands in sequence:
mvn clean
mvn compile -Dmaven.compiler.source=1.5 -Dmaven.compiler.target=1.5
mvn eclipse:clean
mvn -DdownloadSources=true eclipse:eclipse

3. Within Eclipse, select File > Import. In the dialogue box that appears, expand the
Maven node, select Existing Maven Projects and then Next (see Figure 4).
4. On the screen that appears, locate the Root Directory line, select Browse and then
locate and select the RAIDmap Project Workspace directory, then select OK.
5. Select all the projects that Eclipse finds, then select Finish.
6. You should now have compendium and metadata-extractor included in your list of
projects in the Package Explorer pane. For each one in turn, right-click and select
Build Path > Configure Build Path. Select the Libraries tab and remove metadata.jar
from the build path if it appears there, then select OK.
7. If you experience errors relating to the Maven build path for either project, right
click on it in the Package Explorer, select Maven > Update Project Configuration then
select OK in the dialogue box.

8 of 35

redm5rep120510ab10.pdf

RAIDMAP APPLICATION DEVELOPER GUIDE

4 Working with the SourceForge Git repository
If you wish to contribute to the RAIDmap application, you will need to request SSH
access to the RAIDmap Git repository on SourceForge; to do this, visit the profile page
of one of the administrators and send them a message through the SourceForge interface. Otherwise, the code is available anonymously over HTTP and using the special Git
protocol.

4.1 Working from the Command Prompt
You will need to have Git installed and working on your computer. Git is a popular
distributed version control system; it is particularly well suited to projects where the
developers work independently on different copies (forks) of the code and later share
and synchronize (merge) their work. For help on installing and configuring Git, see the
step-by-step instructions provided by GitHub: https://help.github.com/articles/
set-up-git

1. Open up the Git Bash prompt.
2. For read-only access to the RAIDmap code, enter the following command:
git clone git://git.code.sf.net/p/raidmap/code RAIDmap

or for read-write access, use the following command, replacing USERNAME with your
SourceForge user name:
git clone ssh://USERNAME@git.code.sf.net/p/raidmap/code RAIDmap

3. The code will be downloaded to your local Git repository into the RAIDmap directory.
There is not room here to describe how to use Git to track the changes you make to
the source code – there is a helpful online manual you can consult for that: http://
git-scm.com/book/en/ – but to get you started some useful commands follow.
git commit -a -m "Message"

This will save a new version of the code, with all the changes made since the last time you
saved a version (the -a flag lets you skip an intermediate staging process). The Message
bit should be replaced with a description of what you did, so if you ever need to revert
the changes you can find where you made them.
git push origin master

Provided you have set up your SSH access correctly, this will upload your local changes
to the RAIDmap Git repository on SourceForge.

4.2 Working within Eclipse
Recent versions of Eclipse come bundled with a tool called EGit for interacting with Git
repositories.
1. From the menu bar, select File > Import.
2. In the dialogue box that appears, select Git > Projects from Git then Next.

redm5rep120510ab10.pdf
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Figure 5: Importing code from the SourceForge Git repository in Eclipse.

3. Select URI then Next.
4. For read-only access to the RAIDmap code, in the URI box enter git://git.code
.sf.net/p/raidmap/code. For read-write access, enter ssh://git.code.sf.net/
p/raidmap/code, then add your SourceForge user name and password in the appropriate places. The rest of the dialogue box should be filled in automatically for
you (see Figure 5). Select Next.
5. Select the master branch. Select Next.
6. Here you can customize where the code will be stored locally (Directory) and
the name EGit will use for the SourceForge repository (Remote name). Make any
changes you wish, then select Finish.
7. Once the code has downloaded, import the extra libraries into your local Maven
repository using the scripts described in Section 3.1.
8. Select File > Import again. This time select Maven > Existing Maven Projects then
Next.
9. Locate the Root Directory line, select Browse and select the folder into which you
downloaded the source code, then select OK.
10. Make sure only the compendium and metadata-extractor projects are selected, then
select Finish.
When working on the code, you can access the EGit functions by right-clicking on the
RAIDmap project in Project Explorer and navigating to Team in the context menu. Use
Commit to save a new version of your code in your local repository, and use Remote >
Push to push these changes up to the SourceForge repository (if you have SSH access).
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5 Building the Windows installer with IzPack
1. Make sure that IzPack is installed. The latest version may be downloaded from the
IzPack Web site here: http://izpack.org/
2. Prepare the RAIDMap application using Maven build tool (see Section 3.2). This
will produce a jar file called raidmap.jar alongside other files required to run the
application.
3. Create an empty directory somewhere on your system and call it, for example,
RAIDmap Installer.
4. Add the following files and directories from your built application and the Installer
directory in the RAIDmap Project Workspace to the RAIDmap Installer directory:
• exe.ico
• install.xml
• Licence.txt
• raidmap.jar
• Readme.txt
• shortcutSpec.xml
• METADATA_BASE
• Skins
• System
Ensure that none of these files or directories has a read-only flag set, and that there
are no permissions issues with modifying them.
5. Within the RAIDMap Installer directory, create a subdirectory called bin.
6. Locate IzPack’s native directory. On Windows, this is installed by default to C:
\Program Files\IzPack\bin\native. Copy this directory to the bin directory you
just created.
7. Open the install.xml file in a text or XML editor. Towards the end are a couple
of native elements that need to be altered depending on the OS and architecture
of the machine that will run the installer. For 32-bit Windows, they should read as
follows:
<native type="izpack" name="ShellLink.dll"/>
<native type="3rdparty" name="COIOSHelper.dll" stage="both">
<os family="windows"/>
</native>

while for 64-bit Windows, they should look like this:
<native type="izpack" name="ShellLink_x64.dll"/>
<native type="3rdparty" name="COIOSHelper_x64.dll" stage="both">
<os family="windows"/>
</native>

Save any changes and close the file.

redm5rep120510ab10.pdf
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Figure 6: Directory containing the necessary components for building the installer.

8. Your RAIDMap Installer directory should now look like the one shown in Figure 6.
Open a Command Prompt within that directory and run the following command,
remembering to change the path to the installation directory of IzPack if it is
different, and to replace xxbit with either 32bit or 64bit as appropriate:
C:\Program Files\IzPack\bin\compile install.xml -h C:\Program Files\
IzPack -o raidmap-install-xxbit-windows.jar

9. This will produce an installer file of the name specified above in the RAIDMap
Installer directory, ready for use or distribution.

6 RAIDmap architecture
The primary part of RAIDmap is contained in the compendium folder. The Java source
code is contained in src\main\java. The list below indicates the structure of the code
but does not enumerate every class or package individually.
com.compendium This is the top level package containing the classes for launching the
application.
• ProjectCompendium: This is the main file that, for example, Eclipse would
need to run in order to test the application.
• Launcher: Attempts to locate and launch an existing installation and if one
cannot be found, installs the application.
• SaveOutput: Redirects application messages to a log file.
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com.compendium.core This package contains utility functions and constants used throughout the application. Its subpackages deal with the underlying data model and
databases.
• CoreCalendar: Contains functions for working with times and dates.
• CoreUtilities: Contains functions for working with files, sanitizing database
inputs and outputs, etc.
• ICoreConstants: Defines constants for, among other things, node and link
types.
com.compendium.ui This package defines the elements and behaviour of the node
maps.
com.compendium.ui.plaf This package defines further aspects of the look and feel of
map elements such as lines, links and nodes.
com.compendium.ui.toolbars This package defines the toolbars used by the application.
com.compendium.ui.toolbars.system This package controls how the placement and
arrangement of the toolbars may be customized.
com.compendium.ui.menus This package defines the applications menu system.
com.compendium.ui.popups This package defines context menus for various interface
elements.
• UILinkPopupMenu: The context menu for linking arrows.
• UINodePopupMenu: The context menu for nodes, including data record nodes.
com.compendium.ui.dialogs This package defines (most of) the dialogue boxes used
by the application, but not all of their contents.
com.compendium.ui.panels The package defines information/editing panels that are
included as tabs within dialogue boxes.
• UILinkEditPanel: Defines the panel that appears when editing the Contents of a
linking arrow.
• UINodeEditPanel: Defines the panel that appears when editing the Contents of
a node.
com.compendium.ui.linkgroups This package defines a data model and dialogue box
for editing the classifications used for assigning types to links. The default classification is defined in System\resources\LinkGroups\Default.xml and the active
one is stored in System\resources\LinkGroups\Databases
com.compendium.ui.stencils This package defines a data model and dialogue boxes for
editing stencil sets within the application. The RAIDmap stencils are located in
System\resources\Stencils\RAIDmap_development_process.
com.compendium.ui.tags This package defines a data model and dialogue boxes for
editing hierarchies of tags within the application.
com.compendium.ui.edits This package allows edits made within the application to be
turned into objects, so they can be entered into an undo/redo list.
com.compendium.io This package and its subpackages define how application data
may be imported and exported in various formats.

redm5rep120510ab10.pdf

13 of 35

RAIDMAP APPLICATION DEVELOPER GUIDE

uk.ac.bath.raidmap.metadata This package provides the dialogue box that wraps around
the HTML form for editing the metadata associated with nodes.
uk.ac.bath.raidmap.metadata.pathwatch This package provides experimental code for
‘watching’ a directory for changes, and allowing metadata to be entered into the
RAIDmap database without the main application running.
com.compendium.meeting This package and its subpackages provide support for recording meetings in the application. This is not a focus for RAIDmap.
The metadata-extractor folder contains the code for extracting metadata from digital
objects on the file system. Code in the nz.govt packages has not been altered to any great
extent. There are however some additional packages.
uk.ac.bath.raidmap.meta Provides a script interface for running the metadata extractor
from within RAIDmap
• RaidMapCmdLine This is the class called by UINodeEditPanel when a digital
object is associated with a record node.
uk.ac.bath.raidmap.meta.harvester This package provides alternative versions of the
Simple Object Harvester and the Complex Object Harvester for use with RaidMapCmdLine.
uk.ac.bath.raidmap.meta.utils Contains utilities for working with XML documents.

7 Development tasks
7.1 How to extend file types handled by the system
To add a new file type to RAIDmap’s repertoire of formats from which it can extract
metadata, the following files must be in place.
1. The metadata extractor needs a data adapter that tells it how to read a file in
the given format. This should be a class file that extends nz.govt.natlib.adapter
.DataAdapter, and conventionally should be called something like nz.govt.natlib
.adapter.ext.MyformatAdapter (e.g. the adapter for a Windows Bitmap is called nz
.govt.natlib.adapter.bmp.BitmapAdapter).
The class should at least implement the abstract methods defined by DataAdapter,
that is, acceptsFile, adapt, getOutputType, getInputType, getName, getDescription, and
getVersion. For hints on how to do this, please consult the existing set of adapters.
These can be found in the metadata-extractor\src\main\java directory.
2. Document Type Definition corresponding to the XML generated by the adapt
method of the adapter, e.g. bmp.dtd. These are kept in the METADATA_BASE\xml
directory within both the compendium and metadata-extractor project directories.
3. XML output template for transforming the XML generated by the adapt method of
the adapter into XML that can be used by the RAIDmap form, e.g. bmp_to_raidmap
.xslt. Again, for hints on writing such a template, please consult the existing
ones. These are also kept in the METADATA_BASE\xml directory within both the
compendium and metadata-extractor project directories.
Note that each format can have a different set of mandatory metadata, depending
on its significant properties.
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Please consider contributing any data adapters and DTDs you write to the Metadata
Extractor project as well as to RAIDmap.

7.2 How to customize the metadata collected
There are three different metadata forms presented to users.
• The form used for physical objects is METADATA_BASE\harvested\raidmap\physicalObject
.xml.
• The form used for physical specimens is METADATA_BASE\harvested\raidmap\
physicalSpecimen.xml.
• The form used for digital objects is automatically generated from this template:
METADATA_BASE\harvested\raidmap\RaidmapMetadataForm.xslt. Those parts of
the metadata not included directly in the template are derived from the output
templates used by the metadata extractor (see Section 7.1).
Note that these appear within both the compendium and metadata-extractor project
directories.

7.3 Outstanding issues
The RAIDmap software is currently in an early stage of development, and there are
many adjustments that need to be made before it can be released for beta testing. Any
contributions towards making those adjustments would be warmly welcomed.
A list of outstanding issues is maintained on the SourceForge site: http://sourceforge
.net/p/raidmap/tickets/.
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Appendices
1 Contributors
Original code contributions to RAIDmap (i.e. those not available as part of the software
on which it is based) were made by:
• Uday Thangarajah (uday_thang@hotmail.com)
• Alex Ball, UKOLN, University of Bath (a.ball@ukoln.ac.uk)
Contributions in the form of project management, architectural design, functional specification, user testing and documentation were made by:
• Alex Ball, UKOLN
• Mansur Darlington, IdMRC, University of Bath (m.j.darlington@bath.ac.uk)
• Chris McMahon, IdMRC, University of Bath (c.a.mcmahon@bath.ac.uk)
• Uday Thangarajah

2 Copyright
© Copyright 2012 University of Bath.
RAIDmap is free software: you can redistribute it and/or modify it under the terms of the
GNU Lesser General Public License as published by the Free Software Foundation, either
version 3 of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but without any warranty;
without even the implied warranty of merchantability or fitness for a particular
purpose. See the GNU Lesser General Public License for more details.
The full text of the LGPL version 3 is included as Appendix 3, and may be consulted
online: http://www.gnu.org/licenses/lgpl-3.0.html.
The full text of the GPL version 3 is included as Appendix 4, and may be consulted online:
http://www.gnu.org/licenses/gpl-3.0.html.
This version of RAIDmap is based on version 1.5.2 of Compendium, which is © Copyright 2009 Verizon Communications USA and The Open University UK, and distributed
under the LGPL version 3. For more information, see http://compendium.open.ac.uk/
institute/download/download.htm.
Additionally, the disclaimer for Compendium reads as follows:
‘This software is provided by the copyright holders and contributors “as is”
and any express or implied warranties, including, but not limited to, the
implied warranties of merchantability and fitness for a particular purpose are
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disclaimed. In no event shall the copyright owner or contributors be liable for
any direct, indirect, incidental, special, exemplary, or consequential damages
(including, but not limited to, procurement of substitute goods or services;
loss of use, data, or profits; or business interruption) however caused and on
any theory of liability, whether in contract, strict liability, or tort (including
negligence or otherwise) arising in any way out of the use of this software,
even if advised of the possibility of such damage.’
RAIDmap also incorporates the following software:
1. Metadata Extractor, version 3.4, is © Copyright 2010 The National Library of New
Zealand, and distributed under the Apache Licence, version 2. For more information, see http://meta-extractor.sourceforge.net/
2. Derby Database, version 10.0, is © Copyright 2004-2011 The Apache Software
Foundation, and distributed under the Apache Licence, version 2. For more information, see http://db.apache.org/derby/
Code written for RAIDmap within the Java package uk.ac.bath.raidmap.meta and
its subpackages, and within the source folder metadata-extractor\METADATA_BASE\
harvested\raidmap, is also distributed under the Apache Licence, version 2.
The full text of the Apache Licence, version 2, is included as Appendix 5, and may be
consulted online: http://www.apache.org/licenses/LICENSE-2.0.
More details about the copyright and licensing of the above two pieces of software may
be found within their respective source code directories.

3 Lesser General Public Licence
Version 3, 29 June 2007
Copyright © 2007 Free Software Foundation, Inc. http://fsf.org/
Everyone is permitted to copy and distribute verbatim copies of this
license document, but changing it is not allowed.
This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the additional
permissions listed below.

3.0 Additional Definitions
As used herein, “this License” refers to version 3 of the GNU Lesser General Public License,
and the “GNU GPL” refers to version 3 of the GNU General Public License.
“The Library” refers to a covered work governed by this License, other than an Application
or a Combined Work as defined below.
An “Application” is any work that makes use of an interface provided by the Library, but
which is not otherwise based on the Library. Defining a subclass of a class defined by the
Library is deemed a mode of using an interface provided by the Library.
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A “Combined Work” is a work produced by combining or linking an Application with the
Library. The particular version of the Library with which the Combined Work was made
is also called the “Linked Version”.
The “Minimal Corresponding Source” for a Combined Work means the Corresponding
Source for the Combined Work, excluding any source code for portions of the Combined
Work that, considered in isolation, are based on the Application, and not on the Linked
Version.
The “Corresponding Application Code” for a Combined Work means the object code
and/or source code for the Application, including any data and utility programs needed
for reproducing the Combined Work from the Application, but excluding the System
Libraries of the Combined Work.

3.1 Exception to Section 3 of the GNU GPL
You may convey a covered work under sections 3 and 4 of this License without being
bound by section 3 of the GNU GPL.

3.2 Conveying Modified Versions
If you modify a copy of the Library, and, in your modifications, a facility refers to a
function or data to be supplied by an Application that uses the facility (other than as
an argument passed when the facility is invoked), then you may convey a copy of the
modified version:
a) under this License, provided that you make a good faith effort to ensure that, in the
event an Application does not supply the function or data, the facility still operates,
and performs whatever part of its purpose remains meaningful, or
b) under the GNU GPL, with none of the additional permissions of this License applicable to that copy.

3.3 Object Code Incorporating Material from Library Header Files
The object code form of an Application may incorporate material from a header file that
is part of the Library. You may convey such object code under terms of your choice,
provided that, if the incorporated material is not limited to numerical parameters, data
structure layouts and accessors, or small macros, inline functions and templates (ten or
fewer lines in length), you do both of the following:
a) Give prominent notice with each copy of the object code that the Library is used in
it and that the Library and its use are covered by this License.
b) Accompany the object code with a copy of the GNU GPL and this license document.

3.4 Combined Works
You may convey a Combined Work under terms of your choice that, taken together,
effectively do not restrict modification of the portions of the Library contained in the
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Combined Work and reverse engineering for debugging such modifications, if you also
do each of the following:
a) Give prominent notice with each copy of the Combined Work that the Library is
used in it and that the Library and its use are covered by this License.
b) Accompany the Combined Work with a copy of the GNU GPL and this license
document.
c) For a Combined Work that displays copyright notices during execution, include
the copyright notice for the Library among these notices, as well as a reference
directing the user to the copies of the GNU GPL and this license document.
d) Do one of the following:
0) Convey the Minimal Corresponding Source under the terms of this License,
and the Corresponding Application Code in a form suitable for, and under
terms that permit, the user to recombine or relink the Application with a
modified version of the Linked Version to produce a modified Combined
Work, in the manner specified by section 6 of the GNU GPL for conveying
Corresponding Source.
1) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library already
present on the user’s computer system, and (b) will operate properly with a
modified version of the Library that is interface-compatible with the Linked
Version.
e) Provide Installation Information, but only if you would otherwise be required to
provide such information under section 6 of the GNU GPL, and only to the extent
that such information is necessary to install and execute a modified version of
the Combined Work produced by recombining or relinking the Application with
a modified version of the Linked Version. (If you use option 4d0, the Installation
Information must accompany the Minimal Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation
Information in the manner specified by section 6 of the GNU GPL for conveying
Corresponding Source.)

3.5 Combined Libraries
You may place library facilities that are a work based on the Library side by side in a
single library together with other library facilities that are not Applications and are not
covered by this License, and convey such a combined library under terms of your choice,
if you do both of the following:
a) Accompany the combined library with a copy of the same work based on the
Library, uncombined with any other library facilities, conveyed under the terms of
this License.
b) Give prominent notice with the combined library that part of it is a work based on
the Library, and explaining where to find the accompanying uncombined form of
the same work.
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3.6 Revised Versions of the GNU Lesser General Public License
The Free Software Foundation may publish revised and/or new versions of the GNU
Lesser General Public License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Library as you received it
specifies that a certain numbered version of the GNU Lesser General Public License “or
any later version” applies to it, you have the option of following the terms and conditions
either of that published version or of any later version published by the Free Software
Foundation. If the Library as you received it does not specify a version number of the
GNU Lesser General Public License, you may choose any version of the GNU Lesser
General Public License ever published by the Free Software Foundation.
If the Library as you received it specifies that a proxy can decide whether future versions
of the GNU Lesser General Public License shall apply, that proxy’s public statement of
acceptance of any version is permanent authorization for you to choose that version for
the Library.

4 General Public Licence
Version 3, 29 June 2007
Copyright © 2007 Free Software Foundation, Inc. http://fsf.org/
Everyone is permitted to copy and distribute verbatim copies of this
license document, but changing it is not allowed.

4.1 Preamble
The GNU General Public License is a free, copyleft license for software and other kinds of
works.
The licenses for most software and other practical works are designed to take away your
freedom to share and change the works. By contrast, the GNU General Public License is
intended to guarantee your freedom to share and change all versions of a program–to
make sure it remains free software for all its users. We, the Free Software Foundation,
use the GNU General Public License for most of our software; it applies also to any other
work released this way by its authors. You can apply it to your programs, too.
When we speak of free software, we are referring to freedom, not price. Our General
Public Licenses are designed to make sure that you have the freedom to distribute copies
of free software (and charge for them if you wish), that you receive source code or can get
it if you want it, that you can change the software or use pieces of it in new free programs,
and that you know you can do these things.
To protect your rights, we need to prevent others from denying you these rights or asking
you to surrender the rights. Therefore, you have certain responsibilities if you distribute
copies of the software, or if you modify it: responsibilities to respect the freedom of
others.
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For example, if you distribute copies of such a program, whether gratis or for a fee, you
must pass on to the recipients the same freedoms that you received. You must make sure
that they, too, receive or can get the source code. And you must show them these terms
so they know their rights.
Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission to copy,
distribute and/or modify it.
For the developers’ and authors’ protection, the GPL clearly explains that there is no
warranty for this free software. For both users’ and authors’ sake, the GPL requires that
modified versions be marked as changed, so that their problems will not be attributed
erroneously to authors of previous versions.
Some devices are designed to deny users access to install or run modified versions of
the software inside them, although the manufacturer can do so. This is fundamentally
incompatible with the aim of protecting users’ freedom to change the software. The
systematic pattern of such abuse occurs in the area of products for individuals to use,
which is precisely where it is most unacceptable. Therefore, we have designed this version
of the GPL to prohibit the practice for those products. If such problems arise substantially
in other domains, we stand ready to extend this provision to those domains in future
versions of the GPL, as needed to protect the freedom of users.
Finally, every program is threatened constantly by software patents. States should not
allow patents to restrict development and use of software on general-purpose computers,
but in those that do, we wish to avoid the special danger that patents applied to a free
program could make it effectively proprietary. To prevent this, the GPL assures that
patents cannot be used to render the program non-free.
The precise terms and conditions for copying, distribution and modification follow.

4.2 Terms and Conditions
4.2.0 Definitions
“This License” refers to version 3 of the GNU General Public License.
“Copyright” also means copyright-like laws that apply to other kinds of works, such as
semiconductor masks.
“The Program” refers to any copyrightable work licensed under this License. Each licensee
is addressed as “you”. “Licensees” and “recipients” may be individuals or organizations.
To “modify” a work means to copy from or adapt all or part of the work in a fashion
requiring copyright permission, other than the making of an exact copy. The resulting
work is called a “modified version” of the earlier work or a work “based on” the earlier
work.
A “covered work” means either the unmodified Program or a work based on the Program.
To “propagate” a work means to do anything with it that, without permission, would
make you directly or secondarily liable for infringement under applicable copyright law,
except executing it on a computer or modifying a private copy. Propagation includes
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copying, distribution (with or without modification), making available to the public, and
in some countries other activities as well.
To “convey” a work means any kind of propagation that enables other parties to make
or receive copies. Mere interaction with a user through a computer network, with no
transfer of a copy, is not conveying.
An interactive user interface displays “Appropriate Legal Notices” to the extent that it
includes a convenient and prominently visible feature that (1) displays an appropriate
copyright notice, and (2) tells the user that there is no warranty for the work (except to
the extent that warranties are provided), that licensees may convey the work under this
License, and how to view a copy of this License. If the interface presents a list of user
commands or options, such as a menu, a prominent item in the list meets this criterion.

4.2.1 Source Code
The “source code” for a work means the preferred form of the work for making modifications to it. “Object code” means any non-source form of a work.
A “Standard Interface” means an interface that either is an official standard defined by
a recognized standards body, or, in the case of interfaces specified for a particular programming language, one that is widely used among developers working in that language.
The “System Libraries” of an executable work include anything, other than the work as
a whole, that (a) is included in the normal form of packaging a Major Component, but
which is not part of that Major Component, and (b) serves only to enable use of the
work with that Major Component, or to implement a Standard Interface for which an
implementation is available to the public in source code form. A “Major Component”, in
this context, means a major essential component (kernel, window system, and so on) of
the specific operating system (if any) on which the executable work runs, or a compiler
used to produce the work, or an object code interpreter used to run it.
The “Corresponding Source” for a work in object code form means all the source code
needed to generate, install, and (for an executable work) run the object code and to
modify the work, including scripts to control those activities. However, it does not
include the work’s System Libraries, or general-purpose tools or generally available free
programs which are used unmodified in performing those activities but which are not
part of the work. For example, Corresponding Source includes interface definition files
associated with source files for the work, and the source code for shared libraries and
dynamically linked subprograms that the work is specifically designed to require, such as
by intimate data communication or control flow between those subprograms and other
parts of the work.
The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.
The Corresponding Source for a work in source code form is that same work.

4.2.2 Basic Permissions
All rights granted under this License are granted for the term of copyright on the Program,
and are irrevocable provided the stated conditions are met. This License explicitly affirms
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your unlimited permission to run the unmodified Program. The output from running a
covered work is covered by this License only if the output, given its content, constitutes a
covered work. This License acknowledges your rights of fair use or other equivalent, as
provided by copyright law.
You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey covered works
to others for the sole purpose of having them make modifications exclusively for you, or
provide you with facilities for running those works, provided that you comply with the
terms of this License in conveying all material for which you do not control copyright.
Those thus making or running the covered works for you must do so exclusively on your
behalf, under your direction and control, on terms that prohibit them from making any
copies of your copyrighted material outside their relationship with you.
Conveying under any other circumstances is permitted solely under the conditions stated
below. Sublicensing is not allowed; section 10 makes it unnecessary.

4.2.3 Protecting Users’ Legal Rights From Anti-Circumvention Law
No covered work shall be deemed part of an effective technological measure under any
applicable law fulfilling obligations under article 11 of the WIPO copyright treaty adopted
on 20 December 1996, or similar laws prohibiting or restricting circumvention of such
measures.
When you convey a covered work, you waive any legal power to forbid circumvention of
technological measures to the extent such circumvention is effected by exercising rights
under this License with respect to the covered work, and you disclaim any intention to
limit operation or modification of the work as a means of enforcing, against the work’s
users, your or third parties’ legal rights to forbid circumvention of technological measures.

4.2.4 Conveying Verbatim Copies
You may convey verbatim copies of the Program’s source code as you receive it, in any
medium, provided that you conspicuously and appropriately publish on each copy an
appropriate copyright notice; keep intact all notices stating that this License and any
non-permissive terms added in accord with section 7 apply to the code; keep intact all
notices of the absence of any warranty; and give all recipients a copy of this License along
with the Program.
You may charge any price or no price for each copy that you convey, and you may offer
support or warranty protection for a fee.

4.2.5 Conveying Modified Source Versions
You may convey a work based on the Program, or the modifications to produce it from
the Program, in the form of source code under the terms of section 4, provided that you
also meet all of these conditions:
a) The work must carry prominent notices stating that you modified it, and giving a
relevant date.
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b) The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies the
requirement in section 4 to “keep intact all notices”.
c) You must license the entire work, as a whole, under this License to anyone who
comes into possession of a copy. This License will therefore apply, along with any
applicable section 7 additional terms, to the whole of the work, and all its parts,
regardless of how they are packaged. This License gives no permission to license
the work in any other way, but it does not invalidate such permission if you have
separately received it.
d) If the work has interactive user interfaces, each must display Appropriate Legal
Notices; however, if the Program has interactive interfaces that do not display
Appropriate Legal Notices, your work need not make them do so.
A compilation of a covered work with other separate and independent works, which are
not by their nature extensions of the covered work, and which are not combined with it
such as to form a larger program, in or on a volume of a storage or distribution medium,
is called an “aggregate” if the compilation and its resulting copyright are not used to limit
the access or legal rights of the compilation’s users beyond what the individual works
permit. Inclusion of a covered work in an aggregate does not cause this License to apply
to the other parts of the aggregate.

4.2.6 Conveying Non-Source Forms
You may convey a covered work in object code form under the terms of sections 4 and 5,
provided that you also convey the machine-readable Corresponding Source under the
terms of this License, in one of these ways:
a) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source fixed on a
durable physical medium customarily used for software interchange.
b) Convey the object code in, or embodied in, a physical product (including a physical
distribution medium), accompanied by a written offer, valid for at least three years
and valid for as long as you offer spare parts or customer support for that product
model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for all the software in the product that is covered by this License,
on a durable physical medium customarily used for software interchange, for a
price no more than your reasonable cost of physically performing this conveying of
source, or (2) access to copy the Corresponding Source from a network server at no
charge.
c) Convey individual copies of the object code with a copy of the written offer to
provide the Corresponding Source. This alternative is allowed only occasionally
and noncommercially, and only if you received the object code with such an offer,
in accord with subsection 6b.
d) Convey the object code by offering access from a designated place (gratis or for a
charge), and offer equivalent access to the Corresponding Source in the same way
through the same place at no further charge. You need not require recipients to
copy the Corresponding Source along with the object code. If the place to copy the
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object code is a network server, the Corresponding Source may be on a different
server (operated by you or a third party) that supports equivalent copying facilities,
provided you maintain clear directions next to the object code saying where to
find the Corresponding Source. Regardless of what server hosts the Corresponding
Source, you remain obligated to ensure that it is available for as long as needed to
satisfy these requirements.
e) Convey the object code using peer-to-peer transmission, provided you inform
other peers where the object code and Corresponding Source of the work are being
offered to the general public at no charge under subsection 6d.
A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the object code
work.
A “User Product” is either (1) a “consumer product”, which means any tangible personal
property which is normally used for personal, family, or household purposes, or (2)
anything designed or sold for incorporation into a dwelling. In determining whether a
product is a consumer product, doubtful cases shall be resolved in favor of coverage. For
a particular product received by a particular user, “normally used” refers to a typical or
common use of that class of product, regardless of the status of the particular user or
of the way in which the particular user actually uses, or expects or is expected to use,
the product. A product is a consumer product regardless of whether the product has
substantial commercial, industrial or non-consumer uses, unless such uses represent the
only significant mode of use of the product.
“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified versions of a
covered work in that User Product from a modified version of its Corresponding Source.
The information must suffice to ensure that the continued functioning of the modified
object code is in no case prevented or interfered with solely because modification has
been made.
If you convey an object code work under this section in, or with, or specifically for use in,
a User Product, and the conveying occurs as part of a transaction in which the right of
possession and use of the User Product is transferred to the recipient in perpetuity or
for a fixed term (regardless of how the transaction is characterized), the Corresponding
Source conveyed under this section must be accompanied by the Installation Information.
But this requirement does not apply if neither you nor any third party retains the ability
to install modified object code on the User Product (for example, the work has been
installed in ROM).
The requirement to provide Installation Information does not include a requirement
to continue to provide support service, warranty, or updates for a work that has been
modified or installed by the recipient, or for the User Product in which it has been
modified or installed. Access to a network may be denied when the modification itself
materially and adversely affects the operation of the network or violates the rules and
protocols for communication across the network.
Corresponding Source conveyed, and Installation Information provided, in accord with
this section must be in a format that is publicly documented (and with an implementation
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available to the public in source code form), and must require no special password or
key for unpacking, reading or copying.

4.2.7 Additional Terms
“Additional permissions” are terms that supplement the terms of this License by making
exceptions from one or more of its conditions. Additional permissions that are applicable
to the entire Program shall be treated as though they were included in this License, to
the extent that they are valid under applicable law. If additional permissions apply only
to part of the Program, that part may be used separately under those permissions, but
the entire Program remains governed by this License without regard to the additional
permissions.
When you convey a copy of a covered work, you may at your option remove any additional
permissions from that copy, or from any part of it. (Additional permissions may be written
to require their own removal in certain cases when you modify the work.) You may place
additional permissions on material, added by you to a covered work, for which you have
or can give appropriate copyright permission.
Notwithstanding any other provision of this License, for material you add to a covered
work, you may (if authorized by the copyright holders of that material) supplement the
terms of this License with terms:
a) Disclaiming warranty or limiting liability differently from the terms of sections 15
and 16 of this License; or
b) Requiring preservation of specified reasonable legal notices or author attributions
in that material or in the Appropriate Legal Notices displayed by works containing
it; or
c) Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different from the
original version; or
d) Limiting the use for publicity purposes of names of licensors or authors of the
material; or
e) Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or
f) Requiring indemnification of licensors and authors of that material by anyone who
conveys the material (or modified versions of it) with contractual assumptions of
liability to the recipient, for any liability that these contractual assumptions directly
impose on those licensors and authors.
All other non-permissive additional terms are considered “further restrictions” within
the meaning of section 10. If the Program as you received it, or any part of it, contains
a notice stating that it is governed by this License along with a term that is a further
restriction, you may remove that term. If a license document contains a further restriction
but permits relicensing or conveying under this License, you may add to a covered work
material governed by the terms of that license document, provided that the further
restriction does not survive such relicensing or conveying.
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If you add terms to a covered work in accord with this section, you must place, in the
relevant source files, a statement of the additional terms that apply to those files, or a
notice indicating where to find the applicable terms.
Additional terms, permissive or non-permissive, may be stated in the form of a separately
written license, or stated as exceptions; the above requirements apply either way.

4.2.8 Termination
You may not propagate or modify a covered work except as expressly provided under this
License. Any attempt otherwise to propagate or modify it is void, and will automatically
terminate your rights under this License (including any patent licenses granted under
the third paragraph of section 11).
However, if you cease all violation of this License, then your license from a particular
copyright holder is reinstated (a) provisionally, unless and until the copyright holder
explicitly and finally terminates your license, and (b) permanently, if the copyright holder
fails to notify you of the violation by some reasonable means prior to 60 days after the
cessation.
Moreover, your license from a particular copyright holder is reinstated permanently if
the copyright holder notifies you of the violation by some reasonable means, this is the
first time you have received notice of violation of this License (for any work) from that
copyright holder, and you cure the violation prior to 30 days after your receipt of the
notice.
Termination of your rights under this section does not terminate the licenses of parties
who have received copies or rights from you under this License. If your rights have been
terminated and not permanently reinstated, you do not qualify to receive new licenses
for the same material under section 10.

4.2.9 Acceptance Not Required for Having Copies
You are not required to accept this License in order to receive or run a copy of the
Program. Ancillary propagation of a covered work occurring solely as a consequence of
using peer-to-peer transmission to receive a copy likewise does not require acceptance.
However, nothing other than this License grants you permission to propagate or modify
any covered work. These actions infringe copyright if you do not accept this License.
Therefore, by modifying or propagating a covered work, you indicate your acceptance of
this License to do so.

4.2.10 Automatic Licensing of Downstream Recipients
Each time you convey a covered work, the recipient automatically receives a license from
the original licensors, to run, modify and propagate that work, subject to this License.
You are not responsible for enforcing compliance by third parties with this License.
An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organizations.
If propagation of a covered work results from an entity transaction, each party to that
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transaction who receives a copy of the work also receives whatever licenses to the work
the party’s predecessor in interest had or could give under the previous paragraph, plus
a right to possession of the Corresponding Source of the work from the predecessor in
interest, if the predecessor has it or can get it with reasonable efforts.
You may not impose any further restrictions on the exercise of the rights granted or
affirmed under this License. For example, you may not impose a license fee, royalty, or
other charge for exercise of rights granted under this License, and you may not initiate
litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent
claim is infringed by making, using, selling, offering for sale, or importing the Program or
any portion of it.

4.2.11 Patents
A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is called the
contributor’s “contributor version”.
A contributor’s “essential patent claims” are all patent claims owned or controlled by the
contributor, whether already acquired or hereafter acquired, that would be infringed by
some manner, permitted by this License, of making, using, or selling its contributor version, but do not include claims that would be infringed only as a consequence of further
modification of the contributor version. For purposes of this definition, “control” includes
the right to grant patent sublicenses in a manner consistent with the requirements of this
License.
Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under
the contributor’s essential patent claims, to make, use, sell, offer for sale, import and
otherwise run, modify and propagate the contents of its contributor version.
In the following three paragraphs, a “patent license” is any express agreement or commitment, however denominated, not to enforce a patent (such as an express permission
to practice a patent or covenant not to sue for patent infringement). To “grant” such
a patent license to a party means to make such an agreement or commitment not to
enforce a patent against the party.
If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge and under the
terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding Source to be so available,
or (2) arrange to deprive yourself of the benefit of the patent license for this particular
work, or (3) arrange, in a manner consistent with the requirements of this License, to
extend the patent license to downstream recipients. “Knowingly relying” means you have
actual knowledge that, but for the patent license, your conveying the covered work in a
country, or your recipient’s use of the covered work in a country, would infringe one or
more identifiable patents in that country that you have reason to believe are valid.
If, pursuant to or in connection with a single transaction or arrangement, you convey,
or propagate by procuring conveyance of, a covered work, and grant a patent license
to some of the parties receiving the covered work authorizing them to use, propagate,
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modify or convey a specific copy of the covered work, then the patent license you grant
is automatically extended to all recipients of the covered work and works based on it.
A patent license is “discriminatory” if it does not include within the scope of its coverage,
prohibits the exercise of, or is conditioned on the non-exercise of one or more of the
rights that are specifically granted under this License. You may not convey a covered
work if you are a party to an arrangement with a third party that is in the business of
distributing software, under which you make payment to the third party based on the
extent of your activity of conveying the work, and under which the third party grants, to
any of the parties who would receive the covered work from you, a discriminatory patent
license (a) in connection with copies of the covered work conveyed by you (or copies
made from those copies), or (b) primarily for and in connection with specific products or
compilations that contain the covered work, unless you entered into that arrangement,
or that patent license was granted, prior to 28 March 2007.
Nothing in this License shall be construed as excluding or limiting any implied license or
other defenses to infringement that may otherwise be available to you under applicable
patent law.

4.2.12 No Surrender of Others’ Freedom
If conditions are imposed on you (whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not excuse you from the conditions of
this License. If you cannot convey a covered work so as to satisfy simultaneously your
obligations under this License and any other pertinent obligations, then as a consequence
you may not convey it at all. For example, if you agree to terms that obligate you to collect
a royalty for further conveying from those to whom you convey the Program, the only
way you could satisfy both those terms and this License would be to refrain entirely from
conveying the Program.

4.2.13 Use with the GNU Affero General Public License
Notwithstanding any other provision of this License, you have permission to link or
combine any covered work with a work licensed under version 3 of the GNU Affero
General Public License into a single combined work, and to convey the resulting work.
The terms of this License will continue to apply to the part which is the covered work,
but the special requirements of the GNU Affero General Public License, section 13,
concerning interaction through a network will apply to the combination as such.

4.2.14 Revised Versions of this License
The Free Software Foundation may publish revised and/or new versions of the GNU
General Public License from time to time. Such new versions will be similar in spirit to
the present version, but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies that
a certain numbered version of the GNU General Public License “or any later version”
applies to it, you have the option of following the terms and conditions either of that
numbered version or of any later version published by the Free Software Foundation. If
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the Program does not specify a version number of the GNU General Public License, you
may choose any version ever published by the Free Software Foundation.
If the Program specifies that a proxy can decide which future versions of the GNU General
Public License can be used, that proxy’s public statement of acceptance of a version
permanently authorizes you to choose that version for the Program.
Later license versions may give you additional or different permissions. However, no
additional obligations are imposed on any author or copyright holder as a result of your
choosing to follow a later version.

4.2.15 Disclaimer of Warranty
There is no warranty for the program, to the extent permitted by applicable law.
Except when otherwise stated in writing the copyright holders and/or other parties
provide the program “as is” without warranty of any kind, either expressed or
implied, including, but not limited to, the implied warranties of merchantability and
fitness for a particular purpose. The entire risk as to the quality and performance
of the program is with you. Should the program prove defective, you assume the
cost of all necessary servicing, repair or correction.

4.2.16 Limitation of Liability
In no event unless required by applicable law or agreed to in writing will any
copyright holder, or any other party who modifies and/or conveys the program
as permitted above, be liable to you for damages, including any general, special,
incidental or consequential damages arising out of the use or inability to use
the program (including but not limited to loss of data or data being rendered
inaccurate or losses sustained by you or third parties or a failure of the program
to operate with any other programs), even if such holder or other party has been
advised of the possibility of such damages.

4.2.17 Interpretation of Sections 4.2.15 and 4.2.16
If the disclaimer of warranty and limitation of liability provided above cannot be given
local legal effect according to their terms, reviewing courts shall apply local law that
most closely approximates an absolute waiver of all civil liability in connection with the
Program, unless a warranty or assumption of liability accompanies a copy of the Program
in return for a fee.

4.3 How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to
the public, the best way to achieve this is to make it free software which everyone can
redistribute and change under these terms.
To do so, attach the following notices to the program. It is safest to attach them to the
start of each source file to most effectively state the exclusion of warranty; and each file
should have at least the “copyright” line and a pointer to where the full notice is found.
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<one line to give the program’s name and a brief idea of what it does.>
Copyright (C) <textyear> <name of author>
This program is free software: you can redistribute it and/or modify it
under the terms of the GNU General Public License as published by the Free
Software Foundation, either version 3 of the License, or (at your option)
any later version.
This program is distributed in the hope that it will be useful, but WITHOUT
ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for
more details.
You should have received a copy of the GNU General Public License along
with this program. If not, see <http://www.gnu.org/licenses/>.

Also add information on how to contact you by electronic and paper mail.
If the program does terminal interaction, make it output a short notice like this when it
starts in an interactive mode:
<program> Copyright (C) <year> <name of author>
This program comes with ABSOLUTELY NO WARRANTY; for details type ‘show w’.
This is free software, and you are welcome to redistribute it under certain
conditions; type ‘show c’ for details.

The hypothetical commands show w and show c should show the appropriate parts of
the General Public License. Of course, your program’s commands might be different; for
a GUI interface, you would use an “about box”.
You should also get your employer (if you work as a programmer) or school, if any, to
sign a “copyright disclaimer” for the program, if necessary. For more information on this,
and how to apply and follow the GNU GPL, see http://www.gnu.org/licenses/.
The GNU General Public License does not permit incorporating your program into proprietary programs. If your program is a subroutine library, you may consider it more
useful to permit linking proprietary applications with the library. If this is what you want
to do, use the GNU Lesser General Public License instead of this License. But first, please
read http://www.gnu.org/philosophy/why-not-lgpl.html.

5 Apache Licence
Version 2.0, January 2004
http://www.apache.org/licenses/

5.1 Terms and Conditions for Use, Reproduction and Distribution
5.1.1 Definitions
“License” shall mean the terms and conditions for use, reproduction, and distribution as
defined by Sections 1 through 9 of this document.
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“Licensor” shall mean the copyright owner or entity authorized by the copyright owner
that is granting the License.
“Legal Entity” shall mean the union of the acting entity and all other entities that control,
are controlled by, or are under common control with that entity. For the purposes of
this definition, “control” means (i) the power, direct or indirect, to cause the direction or
management of such entity, whether by contract or otherwise, or (ii) ownership of fifty
percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such
entity.
“You” (or “Your”) shall mean an individual or Legal Entity exercising permissions granted
by this License.
“Source” form shall mean the preferred form for making modifications, including but not
limited to software source code, documentation source, and configuration files.
“Object” form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not limited to compiled object code, generated
documentation, and conversions to other media types.
“Work” shall mean the work of authorship, whether in Source or Object form, made
available under the License, as indicated by a copyright notice that is included in or
attached to the work (an example is provided in the Appendix below).
“Derivative Works” shall mean any work, whether in Source or Object form, that is based
on (or derived from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of authorship.
For the purposes of this License, Derivative Works shall not include works that remain
separable from, or merely link (or bind by name) to the interfaces of, the Work and
Derivative Works thereof.
“Contribution” shall mean any work of authorship, including the original version of the
Work and any modifications or additions to that Work or Derivative Works thereof, that is
intentionally submitted to Licensor for inclusion in the Work by the copyright owner or
by an individual or Legal Entity authorized to submit on behalf of the copyright owner.
For the purposes of this definition, “submitted” means any form of electronic, verbal,
or written communication sent to the Licensor or its representatives, including but
not limited to communication on electronic mailing lists, source code control systems,
and issue tracking systems that are managed by, or on behalf of, the Licensor for the
purpose of discussing and improving the Work, but excluding communication that is
conspicuously marked or otherwise designated in writing by the copyright owner as “Not
a Contribution.”
“Contributor” shall mean Licensor and any individual or Legal Entity on behalf of whom
a Contribution has been received by Licensor and subsequently incorporated within the
Work.

5.1.2 Grant of Copyright License
Subject to the terms and conditions of this License, each Contributor hereby grants to
You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright

32 of 35

redm5rep120510ab10.pdf

RAIDMAP APPLICATION DEVELOPER GUIDE

license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

5.1.3 Grant of Patent License
Subject to the terms and conditions of this License, each Contributor hereby grants to
You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import,
and otherwise transfer the Work, where such license applies only to those patent claims
licensable by such Contributor that are necessarily infringed by their Contribution(s)
alone or by combination of their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including
a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution
incorporated within the Work constitutes direct or contributory patent infringement,
then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

5.1.4 Redistribution
You may reproduce and distribute copies of the Work or Derivative Works thereof in any
medium, with or without modifications, and in Source or Object form, provided that You
meet the following conditions:
1. You must give any other recipients of the Work or Derivative Works a copy of this
License; and
2. You must cause any modified files to carry prominent notices stating that You
changed the files; and
3. You must retain, in the Source form of any Derivative Works that You distribute,
all copyright, patent, trademark, and attribution notices from the Source form of
the Work, excluding those notices that do not pertain to any part of the Derivative
Works; and
4. If the Work includes a “notice” text file as part of its distribution, then any Derivative Works that You distribute must include a readable copy of the attribution
notices contained within such notice file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the following places:
within a notice text file distributed as part of the Derivative Works; within the
Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such thirdparty notices normally appear. The contents of the notice file are for informational
purposes only and do not modify the License. You may add Your own attribution
notices within Derivative Works that You distribute, alongside or as an addendum
to the notice text from the Work, provided that such additional attribution notices
cannot be construed as modifying the License. You may add Your own copyright
statement to Your modifications and may provide additional or different license
terms and conditions for use, reproduction, or distribution of Your modifications,
or for any such Derivative Works as a whole, provided Your use, reproduction,
and distribution of the Work otherwise complies with the conditions stated in this
License.
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5.1.5 Submission of Contributions
Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this
License, without any additional terms or conditions. Notwithstanding the above, nothing
herein shall supersede or modify the terms of any separate license agreement you may
have executed with Licensor regarding such Contributions.

5.1.6 Trademarks
This License does not grant permission to use the trade names, trademarks, service marks,
or product names of the Licensor, except as required for reasonable and customary use
in describing the origin of the Work and reproducing the content of the notice file.

5.1.7 Disclaimer of Warranty
Unless required by applicable law or agreed to in writing, Licensor provides the Work (and
each Contributor provides its Contributions) on an “as is” basis, without warranties
or conditions of any kind, either express or implied, including, without limitation, any
warranties or conditions of title, non-infringement, merchantability, or fitness for a
particular purpose. you are solely responsible for determining the appropriateness of
using or redistributing the Work and assume any risks associated with Your exercise of
permissions under this License.

5.1.8 Limitation of Liability
In no event and under no legal theory, whether in tort (including negligence), contract,
or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including
any direct, indirect, special, incidental, or consequential damages of any character arising
as a result of this License or out of the use or inability to use the Work (including but not
limited to damages for loss of goodwill, work stoppage, computer failure or malfunction,
or any and all other commercial damages or losses), even if such Contributor has been
advised of the possibility of such damages.

5.1.9 Accepting Warranty or Additional Liability
While redistributing the Work or Derivative Works thereof, You may choose to offer, and
charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations
and/or rights consistent with this License. However, in accepting such obligations, You
may act only on Your own behalf and on Your sole responsibility, not on behalf of any
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor
harmless for any liability incurred by, or claims asserted against, such Contributor by
reason of your accepting any such warranty or additional liability.

5.2 How to apply the Apache License to your work
To apply the Apache License to your work, attach the following boilerplate notice, with the
fields enclosed by brackets “[]” replaced with your own identifying information. (Don’t
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include the brackets!) The text should be enclosed in the appropriate comment syntax for
the file format. We also recommend that a file or class name and description of purpose
be included on the same “printed page” as the copyright notice for easier identification
within third-party archives.
Copyright [yyyy] [name of copyright owner]
Licensed under the Apache License, Version 2.0 (the “License”); you may not
use this file except in compliance with the License. You may obtain a copy
of the License at
http://www.apache.org/licenses/LICENSE-2.0
Unless required by applicable law or agreed to in writing, software
distributed under the License is distributed on an “AS IS” BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the
License for the specific language governing permissions and limitations
under the License.
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